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Revision Record 
 

Date Version Description 
2011/01/17 1.02 New issue 
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- “Printer Test” and “Drawer Test” was added to Configuration Utility Function. 
(Page 31,32,33) 

2011/06/22 1.12.1.4 - Version number is changed to same version as driver itself. 
- The outline explanation was added to “1. Operating Environment”. (Page 5) 
- The version of .NET Flamework was changed. (Page 5) 
- Release Notes file was added to installation structure. (Page 11) 
- The setting of “Write Buffer” was added to “I/O Setting”. (Page 18) 

2011/09/12 1.12.1.5 - The setting of “Detect the completion of printing” was added to “I/O Setting”. 
(Page 18) 

- The test result of “Testing Device” was changed. (Page 33) 
- "PE output at PNE=Invalid" was added to the memory switch setting table. (Page 

40) 
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Notes 

1. Unauthorized use of all or any part of this document is prohibited. 

2. The information in this document is subject to change without prior notice. 

3. This document has been created with full attention. If, however, you find an error or question, 

please contact us. 

4. We shall not be liable for any effect resulting from operation regardless of the above item 3. 

5. If you do not agree with the above terms, you are not permitted to use this driver. 

 
 
Trademark 

Microsoft, Windows XP, Windows 7, Visual Basic for .NET, C# for .NET, and Visual C++ for .NET are 

registered trademarks of Microsoft Corporation in the United States and/or other countries. (Official 

name for Windows is Microsoft Windows Operating System.) 

Company names and product names appearing on this document are trademarks and/or registered 

trademarks of respective companies. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CITIZEN is a registered trademark of Citizen Holdings Co., Ltd. 
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1. Operating Environment 

“CITIZEN POS for .NET Driver” control the devices by using “.NET Framework”. 

 
It is necessary to set up "Microsoft POS for .NET SDK" and ".NET Framework" separately to use this 

driver. 

 

Supported operating systems 
This product supports the following Microsoft Windows operating systems: 

・ Windows XP 

・ Windows 7 

Microsoft POS for .NET SDK 
Install “Microsoft POS for .NET SDK 1.12” before installing this product. 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=eaae202a-0fcc-406a-8fde-35713d7

841ca&displaylang=en 

SDK contains the documents and sample codes.  

.NET Framework 
The following Microsoft .NET Framework is required to use this product. 

・ Microsoft .NET Framework 2.0 SP2 

・ Microsoft .NET Framework 3.5 SP1 

Supported models 
The models supported by this product and the corresponding interfaces are as listed below. 

Refer to the user’s manual of the printer for the detailed functions of each model. 

Series of Model Object Model Interface Printer Functions 

CT-S310 Serial, Parallel, USB, Ethernet Standard (Paper with blackmark 
on front side is supported.) 

CT-S310 

CT-S310-M1/M2 Serial, Parallel, USB, Ethernet Paper with blackmark on back 
side is supported. 

CT-S310II CT-S310II Serial, USB Standard 

CT-S601/651/801/
851 Serial, Parallel, USB, Ethernet Standard 

CT-S801/851-M Serial, Parallel, USB, Ethernet Blackmark paper is supported. 
CT-S601/651/801
/851 

CT-S801-L Serial, Parallel, USB, Ethernet Label paper is supported. 

CT-S2000 Serial, Parallel, USB, Ethernet Standard 

CT-S2000-M Serial, Parallel, USB, Ethernet Blackmark paper is supported. CT-S2000 

CT-S2000-L Serial, Parallel, USB, Ethernet Label paper is supported. 

Application 

Microsoft 
POS for .NET 

SDK 
(POSExplorer  API)

CITIZEN 
POS for .NET 

Driver 
(Service Object) 

Devices 
(POS Printer) 
(Cash Drawer) 

.NET Framework

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=eaae202a-0fcc-406a-8fde-35713d7841ca&displaylang=en�
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=eaae202a-0fcc-406a-8fde-35713d7841ca&displaylang=en�
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USB interface connection 
You need to install the printer driver to use this product via the USB interface connection. The driver 

to be installed varies by the USB mode setting of the printer:  

1) When the USB mode is the Printer Class 

Install the Windows driver. On the POS for .NET driver, specify the USB interface port (Virtual 

printer port for USB) specified on the Windows driver. 

2) When the USB mode is Virtual COM 

Install the Virtual COM driver. On the POS for .NET driver, specify the serial interface port 

specified on the Virtual COM driver. 

Parallel interface connection 
When the terminal and the printer are connected via the parallel interface, the installation wizard that 

requests the installation of the printer driver may be activated every time when the terminal is started 

up. You need to install the Windows driver to prevent the installation wizard from being activated. 

Installation of the Windows driver 
The Windows drivers that support each model are as listed below. For the installation instruction of 

the Windows driver, refer to the “Windows Driver Guide” that is attached to the Windows driver. 

Object Model Windows Driver Name Printer Function 

CT-S310 CITIZEN CT-S310 Standard (Paper with blackmark on 
front side is supported.) 

CT-S310-M1/M2 CITIZEN CT-S310 Black Mark Paper with blackmark on back side is 
supported. 

CT-S310II CITIZEN CT-S310II Standard 

CT-S601/651/801/851 CITIZEN CT-S601/651/801/851 Standard 

CT-S801/851-M CITIZEN CT-S801/851 Black Mark Blackmark paper is supported. 

CT-S801-L CITIZEN CT-S801 Label Label paper is supported. 

CT-S2000 CITIZEN CT-S2000 Standard 

CT-S2000-M CITIZEN CT-S2000 Label Blackmark paper is supported. 

CT-S2000-L CITIZEN CT-S2000 Label Label paper is supported. 

* This driver cannot be used with the status function (language monitor) of the Windows driver that 
shows the printer status. When using this driver, install the Windows driver without the 
status function, or uncheck the “Enable bidirectional support” option under the Ports 
setting of the Windows driver. (Need to reboot the computer in order for the changes to take 
effect.) 
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Installation of the USB Virtual COM driver 
Install the Virtual COM driver that corresponds to each model. For the installation instruction of the 

Virtual COM driver, refer to the “Virtual COM Driver Installation Guide” that is attached to the Virtual 

COM driver. 

Each model and the corresponding USB virtual COM mode are as listed below: 

Model Name Corresponding Status 
for Virtual COM Mode Port Name (Port Number) 

CT-S310 

CT-S310-M1/M2 
Supported Ctvrcom Virtual Communication Port  

(COM8) 

CT-S310II Supported Ctvrcom Virtual Communication Port  
(COM8) 

CT-S601/651/801/851 

CT-S801/851-M 

CT-S801-L 

Supported Ctvrcom Virtual Communication Port  
(COM8) 

CT-S2000 

CT-S2000-M 

CT-S2000-L 

Supported Ctvrcom Virtual Communication Port  
(COM8) 
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2. Installation 

2.1. Installation Procedure 

This section describes the installation instruction of this product. 

Make sure to terminate all the running applications before starting the installation. 

 

1) Activate CSJ_POSforNET_JA_Vxxxx.exe (the installer, where xxxx represents the version). 

Proceed with the installation by following the instruction of the dialog. 

On Windows 7, click “Yes” when the following “User Account Control” dialog is displayed. 

 

 

2) The Setup Wizard is activated. Click “Next”. 
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3) The “License Agreement” window is displayed.  

Select “I Agree” and click “Next” if you agree with the license agreement. Select “I Do Not Agree” 

and terminate the Setup Wizard if you do not agree with the license agreement. 

 

 

4) The “Select Installation Folder” window is displayed. 

Specify the installation directory. If you do not change the default installation folder, click “Next”. To 

change the default installation folder, specify a desired folder for installation. 
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5) The window to confirm the installation is displayed. Click “Next”. 

 

 

6) The window to show the installation progress is displayed. 

(It may take longer time to complete, depending on the environment and specifications of the 

terminal) 
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7) When the installation is completed successfully, the “Installation Complete” window is displayed. 

Click “Close”.  

 

 

 

2.2. Installation Structure 

This section shows the installation files of this product. 

 

“Installation Folder”¥CITIZEN¥CITIZEN Service Objects for .NET 

 

BcWidth.dll  : Extended library for service objects 

ConfigurationUtility.exe : Driver setting tool 

CSJCheckHealthLib.dll : Extended library for setting tool 

CSJWPOS.dll  : Service objects for the line thermal printer 

EventLog.dll  : Extended library for service objects 

License.rtf  : Driver license agreement 

PortService.exe : Port service 

PortServiceRemote.dll : Extended library for port service 

ReleaseNotes_EN.txt : Release Notes file 
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2.3. Uninstallation Procedure  

This section describes the uninstallation of this product. 

 

Deleting Configuration XML file 
Delete the physical and logical devices in Configuration Utility. 

The Configuration XML file is deleted when everything is deleted. 

For the deletion of a device, see the description in “3.4 Deleting a device”. 

※ It is recommended to leave the registered device setting when upgrading the version of this 

product. 

 

Deleting Service Objects for .NET 
1) Under “Control Panel” - “Programs” - “Programs and Features” (it may be “Add/Remove 

Programs” in some OS versions) list, select “Citizen Service Objects for .NET” and click 

“Uninstall”. 

 

 

2) The message dialog of “Add/Remove Programs” is displayed. 

Click “Yes”. Or, click “No” to cancel the uninstallation of this program. 

 

 

3) The dialog to show the progress of the uninstallation processing is displayed. 
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4) When the uninstallation is completed successfully, “Citizen Service Objects for .NET” is removed 

from the list of the “Programs and Features” (or “Add/Remove Programs” in some OS versions). 
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3. POS for .NET Driver Setting Tool 

This section describes the usage of Configuration Utility. When the driver is installed, the shortcut icon 

is registered in the Windows Start Menu. 

“Start” -> “Programs” -> “CITIZEN” -> “Pos for .NET” -> “Configuration Utility” 

 

Main Screen 

 
 

 

Setting View: The setting of each device is displayed (the setting can be changed directly) 

Device View: The service objects and the logical devices are shown in the tree view. 
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3.1. Adding New Printer and Cash Drawer 

1) Click “Add New Printer” in the “Device” menu. 

 
 

Or, click “Add New Printer” icon on the tool bar. 

 
 

Or, click “Add New Printer” in the context menu on the device view.  

 
 

2) “Add New Printer Wizard” is activated. 

Enter the model and the logical device name of the printer to be added, and click “Next”. 

The default logical device name is the “model name of the printer+ serial number of the printer”. 

(CT-S801 is specified in this example) 
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For the functions of each printer, see “1. Operating Environment”. 

 

3) The “Please choose the printer type” window is displayed. 

Choose the paper width and the maximum columns per line with reference to the table below. 

The setting is linked to the default value of the ”RecLineWidth / RecLineChars / RecLineCharsList” 

properties. 

For details, refer to Application Development Guide of this product. 
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CT-S310 Series 
Paper Size 
（mm） 

Max. print 
columns RecLineWidth RecLineChars RecLineCharsList 

30  360 30 30, 40, 45 
58 

32 384 32 32, 42, 48 

42 504 42 42, 56, 63 
80 

  
48 576 48 48, 64, 72 

 

CT-S310II Series 
Paper Size 
（mm） 

Max. print 
columns RecLineWidth RecLineChars RecLineCharsList 

30  360 30 30, 40, 45 

32 384 32 32, 42, 48 58 

35 420 35 35, 46, 52 

42 512 42 42, 56, 64 

80 

  
48 576 48 48, 64, 72 

 

CT- S601/651/801/851 Series 

Paper Size （mm） Max. print
columns RecLineWidth RecLineChars RecLineCharsList

30 360 30 30, 40, 45 

32 384 32 32, 42, 48 58 

35 420 35 35, 46, 52 
60 

  36 432 36 36, 48, 54 

    42 512 42 42, 56, 64 

80 

    48 576 48 48, 64, 72 

83 

      53 640 53 53, 71, 80 

 

CT- S2000 Series 

Paper Size （mm） Max. print
columns RecLineWidth RecLineChars RecLineCharsList

30 360 30 30, 40, 45 

32 384 32 32, 42, 48 58 

35 420 35 35, 46, 52 
60 

  36 432 36 36, 48, 54 

    42 512 42 42, 56, 64 

80 

    48 576 48 48, 64, 72 

83 

      53 640 53 53, 71, 80 

 
Specify the above settings, and click “Next”. 

 

4) The “Details of Settings” window is displayed.  

The setting of each item is as shown below. 
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Status Back Interval 
You can specify the polling interval to obtain the printer status. 

Setting range: 100 – 900 msec 

Write Timeout 
You can specify the timeout period for the writing to the output port. 

Setting range: 5,000 - 1,000,000 msec 

Write Buffer 
You can specify the buffer size for the writing to the output port. 

Setting range: 0 - 4,096 bytes 

Detect the completion of printing 
When you enable the setting, the driver judges the completion of the printing output. For the 

details of this setting, refer to Application Development Guide of this product. 

International Char 
You can specify the international characters.  

Setting Values: U.S.A/ France/ Germany/ U.K./ DenmarkI /Sweden/ Itary/ SpainI/ Japan/ 

Norway/ DenmarkII/ SpainII/ Latin America/ Korea 

Code Page 
You can specify the code page. (The selections vary by the model) 

Setting Value: 437/ 850/ 852/ 857/ 858/ 860/ 863/ 864/ 865/ 866/ 874/ 932/ 998/ 999/ 1252/ 

User Defined/ 

SetBitmap Mode 
You can specify the bit image mode of the SetBitmap method. For the details of this mode, refer 

to Application Development Guide of this product. 

Setting values: NV Bit Image / Raster Bit Image 

Map Image with BMP File Resolution 
When you enable the setting, a bit image that is specified with the Setbitmap method and 

PrintBitmap is output based on the BMP file resolution. 
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Specify the above settings and click “Next”.  

 

5) The “Please select the port” window is displayed. 

Select the port to use and click “Next”. 

 

 

When the COM port is specified  
The “Serial Port settings” window is displayed. 

Specify “BaudRate”, “Parity” and “Handshake”, and click “Next”. 

* The communication cannot be performed when the same serial port setting is not made on the 

printer and the terminal.  

For the serial port setting of the printer, refer to the user’s manual of the printer. 
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When NET is specified 
The “Network Settings” window is displayed. Input the “IP Address” and the “Port Number” to 

use. 

 

* When “Print Server Settings” is clicked, the print server setting tool is activated. For the usage of 

this tool, refer to the manual attached to the tool. 

* Specify “Job receive timeout” in “Print Server Settings”. 

It is recommended to set the time in seconds to cancel the connection to “120”. 

 

Specify the above settings and click “Next”.  

 

6) “Add New Cash Drawer Wizard” is activated subsequently. 

Specify the number of the cash drawers connected to the printer, and click “Next”. 

 
When “1 Cash Drawer” or “2 Cash Drawer” is specified, the “First drawer settings” window is 

displayed.  
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Please enter the device name 
Enter the logical device name of the cash drawer. 

The default logical device name is “the model name of the printer + the serial number of the 

printer + CD1”.  

(And for the second drawer, it is “the model name of the printer + the serial number of the printer 

+ CD 2”.) 

Signal Length 
Specify the time interval of the pulse signal to be output to the solenoid of the cash drawer. 

Setting range: 1 - 8 (x 100) msec 

Pin3 Connected 
Check when the third pin of the drawer kick connector (drawer switch input) is connected.  

Pin3 Status of Drawer Opened 
Specify the drawer switch input signal level when the cash drawer is opened. 

Setting values: High / Low 

 

Specify the above settings and click “Next”. 

 

※ When “2 Cash Drawer” is specified and “Next” is clicked, the “Second drawer settings” window 

is displayed.  

Make the settings for the second cash drawer in the same manner as the above setting, and 

click “Next”. 

 

7) The “Finish the printer settings” window is displayed. 

Click “Finish”. The settings are not reflected to the Configuration XML file at this point. 

* The settings are not reflected to the Configuration XML file until “Save” is clicked on the Main 

Screen. 

(See the description in “Save” in 3.5 ”File menu” for how to “Save”) 
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8) When the wizard is terminated, the registered printer and the cash drawer are shown in “Device 

View” and “Setting View”. When the drawer is selected, the logical device name of the connected 

printer is added at the tail of the logical device name on the title bar, and the “service object name 

of the connected printer / logical device name of the printer” is shown in the tooltip. 

 

*1  After the device is registered, the setting of each item can be changed directly through the 

Setting View.  The settings are not reflected to the Configuration XML file until “Save” is clicked 

on the Main Screen. (See the description in “Save” in 3.5 ”File menu” for how to “Save”) 

*2  Click “Change IP Address” to change “IP Address” or “Port Number” in the “Network Setting” 

section.  
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3.2. Adding New Cash Drawer 

1) Click “Add Cash Drawer” in the “Device” menu. 

* Make sure to complete the registration of the printer before adding a cash drawer. 

 
 

Or, click the “Add Cash Drawer” icon on the tool bar.  

 

 

Or, click “Add Cash Drawer” in the context menu on the Device View. 

 

 

2)  “Add New Cash Drawer Wizard” is activated.  
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* For the subsequent procedure, see the descriptions in “6) “Add New Cash Drawer Wizard” is 

activated subsequently.” and later in “3.1 Adding a new printer / cash drawer” and add a drawer 

in the same manner.  
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3.3. Modifying Logical Device 

Modify the logical device name of the registered printer or cash drawer. 

 

1) Select the printer or the cash drawer to change the logical device name from the list of 

“PosDevices” in the Device View. 

 

 

2) Click “Modify Device” in the “Device” menu.  

 
 

Or, click the “Modify Device” icon on the tool bar. 

 

 

Or, Click “Modify Device” in the context menu on the Device View. 
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3) The “Modify Device” window is displayed. 

The logical device name of the selected printer or cash drawer before modification is shown in “The 

device name before modification”. Enter the new logical device name in the “Please enter the 

device name” textbox. 

 
Specify the above and click “OK”. Or, click “Cancel” to cancel the above setting. 

 

4) When the above operation is completed, the modified logical device name is shown in the Device 

View. (Circled in red in the image below) 
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3.4. Deleting Device  

Delete a registered physical device (printer or cash drawer). 

* Even after “Delete” or “Delete All” is executed, the setting is not reflected to the Configuration XML file 

until “Save” is clicked on the Main Screen. (See the description in “Save” in 3.5 “File menu” for how to 

“Save”) 

 

Deleting Printer 
1) Select the printer to remove from the list of “PosPrinter” in the Device View.  

 

 

2) Click “Delete” in the “Device” menu.  

 
 

Or, click the “Delete” icon on the tool bar. 
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Or, click “Delete” in the context menu on the Device View. 

 

 

3) The message dialog “Warning – Do you want to delete printer device and associated cash 

drawers” is displayed. Click “Yes”. Or, click “No” to cancel the deletion of the printer. 

 

* When the printer is deleted, the registered drawers are also deleted. 

 

Deleting Cash Drawer 
1) Select a cash drawer to remove from the list of “CashDrawer” in the Device View. 

 
 

2) Click “Delete” in the “Device” menu. 
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Or, click the “Delete” icon on the tool bar. 

 

 

Or, click “Delete” on the context menu on the Device View. 
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Delete all devices (Delete All) 
1) Click “Delete All” in the “Device” menu.  

 
 

2) The message dialog “Warning – Do you want to delete all printer devices and associated cash 

drawers” is displayed. Click “Yes”. Or, click “No” to cancel the delete all. 
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3.5. Testing Device  

Test a registered physical device (printer or cash drawer). 

* Before testing device, it is necessary to save the setting. (See the description in “Save” in 3.5 “File 

menu” for how to “Save”) 

 

Testing Printer 
1) Select the printer to test from the list of “PosPrinter” in the Device View.  

 

 

2) Click “Printer Test” in the “Device” menu.  

 
 

Or, click “Printer Test” on the context menu on the Device View. 
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Testing Cash Drawer 
1) Select a cash drawer to test from the list of “CashDrawer” in the Device View. 

 
 

2) Click “Drawer Test” in the “Device” menu. 

 
 

Or, click “Drawer Test” on the context menu on the Device View. 

 

 

 

 



 
 

33 

CITIZEN POS for .NET DRIVER 1.12 Setup Guide

Test Results 
If you can successfully run the testing, the following message is displayed. 

 

When the printer was selected, the test printing is run. And when the cash drawer was selected, the 

CheckHealth method is run. 

 

If an error occurred calling the testing, like the following error message is displayed. 
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3.6. File Menu 

Save 
1) Click “Save” in the “File” menu. 

 

 

Or, click the “Save” icon on the tool bar. 

 

 

The above operation reflects the current setting to the Configuration XML file. 

* This function can be selected only when a change is made after activation, saving or 

restoration. 

 

Restore 
1) Click “Restore” in the “File” menu. 

 

 

2) The message dialog “This will undo your changes! Are you sure you want to restore?” is displayed. 

Click “Yes”. Or, click “No” to cancel the restoration. 
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The above operation changes the current setting to the state upon the last saving. (When saving 

is not performed after the activation, it is changed to the state immediately after the activation.) 

* This function can be selected only when a change is made after activation, saving or 

restoration.  

 

Exit 
1) Click “Exit” in the “File” menu.  

 

 

2) Upon exiting, the message dialog “Do you want to save your changes?” is displayed when the 

current setting has not been saved in the Configuration XML file (you will exit directly when the 

current setting is saved.) 

Click “Yes” to reflect the current setting to the Configuration XML file and exit the Configuration 

Utility. 

Click “No” to exit the Configuration Utility without reflecting the current setting to the 

Configuration XML file. 

Click “Cancel” to cancel the exit and return to the Main Screen. 
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3.7. Tool Menu 

Setting Print Server  
1) Click “Setting Print Server” in the “Tool” menu. 

 

* The print server setting tool is activated when “Setting Print Server” is clicked. Refer to the 

manual attached to the tool for the usage of this tool.  

 

Setting Option 
1) Click “Setting Option” in the “Tool” menu. 

 

 

2) The “Option” dialog is displayed. 

When the print server setting program has not been installed under the default directory, you can 

specify it on this screen.  

 

 
 

* “C:¥Program Files¥SEH Computertechnik GmbH¥InterCon-NetTool¥InterCon-NetTool.exe” is 

the default setting when the POS for .NET driver is installed. 
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3.8. Help Menu 

Version information 
1) Click “About Configuration Utility” in the “Help” menu. 

 

 

2) The dialog “About Configuration Utility” is displayed. 

You can see the detailed version information of POS for .NET Driver / POS for .NET Configuration 

Utility on this dialog. 
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4. Printer Setting 

It is the prerequisite for the use of this product that the DIP switch and the memory switch of the 

printer are set as listed below. For the switching and the detailed setting of each switch, refer to the 

user’s manual of each model. 

 

4.1. CT-S310 Series 

DIP Switch Setting 
DSW No. Function Setting Description 

8 INIT 
(when serial interface is used) 

OFF Disabled 

 

Memory Switch Setting 
MSW No. Function Setting Description 

1-1 Power ON notify setting OFF Enabled 

1-2 Input buffer OFF 4KB 

1-3 Busy condition ON Buffer full 

1-4 Receiving error character OFF Character? 

1-5 CR mode OFF Disabled 

1-7 Select DSR signal 
(when serial interface is used) 

OFF DSR 

1-8 Select INIT signal 
(when serial interface is used) 

OFF - 

2-2 Auto cutter operation ON Enabled 

2-4 Full Col Print ON Wait Data 

3-1 Auto cutter restore OFF L/F enabled 

3-3 Parallel 31Pin 
（when USB and parallel IF are used)

OFF Reset 

3-7 CBM1000-compatible mode ON Compatible 

3-8 Cover opened while printing OFF Auto restore 

4-8 Forced partial OFF Disabled 

9-1 Code page Katakana - 

9-2 Foreign language characters Japan - 

9-3 Kanji Enable - 

9-4 JIS/Shift-JIS Shift-JIS - 
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4.2. CT-S310II Series 

Memory Switch Setting 
MSW No. Function Setting Description 

1-1 Power ON notify setting OFF Enabled 

1-2 Input buffer OFF 4KB 

1-3 Busy condition ON Buffer full 

1-4 Receiving error character OFF Character? 

1-5 CR mode OFF Disabled 

1-7 Select DSR signal 
(when serial interface is used) 

OFF DSR 

1-8 Select INIT signal 
(when serial interface is used) 

OFF - 

2-2 Auto cutter operation ON Enabled 

2-4 Full Col Print ON Wait Data 

3-1 Auto cutter restore OFF L/F enabled 

3-3 Parallel 31Pin 
（when USB and parallel IF are used)

OFF Reset 

3-7 CBM1000-compatible mode ON Compatible 

3-8 Cover opened while printing OFF Auto restore 

4-8 Forced partial OFF Disabled 

5-2 Vertical basic calculation pitch OFF 360 dots 

6-1 Act. For Driver ON Valid 

7-6 DMA control Enable - 

8-3 Line Gap Reduce Invalid - 

8-4 Reduced Char 100% / 100% - 

8-5 Auto Side Shift Invalid - 

9-1 Code page Katakana - 

9-2 Foreign language characters Japan - 

9-3 Kanji Enable - 

9-4 JIS/Shift-JIS Shift-JIS - 
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4.3. CT-S601/651/801/851 Series 

DIP Switch Setting 
DSW No. Function Setting Description 

8 INIT 
(when serial interface is used) 

OFF Disabled 

 

Memory Switch Setting 
MSW No. Function Setting Description 

1-1 Power ON notify setting OFF Enabled 

1-2 Input buffer OFF 4KB 

1-3 Busy condition ON Buffer full 

1-4 Receiving error character OFF Character? 

1-5 CR mode OFF Disabled 

1-7 Select DSR signal 
(when serial interface is used) 

OFF DSR 

1-8 Select INIT signal 
(when serial interface is used) 

OFF - 

2-2 Auto cutter operation ON Enabled 

2-4 Full Col Print ON Wait Data 

3-1 Auto cutter restore OFF L/F enabled 

3-2 PE output at PNE 
（when parallel IF are used) 

ON Invalid 

3-3 Parallel 31Pin 
（when USB and parallel IF are used)

OFF Reset 

3-7 CBM1000-compatible mode ON Compatible 

3-8 Cover opened while printing OFF Auto restore 

4-8 Forced partial OFF Disabled 

5-2 Vertical basic calculation pitch OFF 360 dots 

6-1 Act. For Driver ON Valid 

7-6 DMA control Enable - 

9-1 Code page Katakana - 

9-2 Foreign language characters Japan - 

9-3 Kanji Enable - 

9-4 JIS/Shift-JIS Shift-JIS - 

10-3 ACK output timing 
（when USB and parallel IF are used)

Before BUSY - 
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4.4. CT-S2000 Series 

DIP Switch Setting 
DSW No. Function Setting Description 

8 INIT 
(when serial interface is used) 

OFF Disabled 

 

Memory Switch Setting 
MSW No. Function Setting Description 

1-1 Power ON notify setting OFF Enabled 

1-2 Input buffer OFF 4KB 

1-3 Busy condition ON Buffer full 

1-4 Receiving error character OFF Character? 

1-5 CR mode OFF Disabled 

1-7 Select DSR signal 
(when serial interface is used) 

OFF DSR 

1-8 Select INIT signal 
(when serial interface is used) 

OFF - 

2-2 Auto cutter operation ON Enabled 

2-4 Full Col Print ON Wait Data 

3-1 Auto cutter restore OFF L/F enabled 

3-3 Parallel 31Pin 
（when USB and parallel IF are used)

OFF Reset 

3-7 CBM1000-compatible mode ON Compatible 

3-8 Cover opened while printing OFF Auto restore 

4-8 Forced partial OFF Disabled 

5-2 Vertical basic calculation pitch OFF 360 dots 

7-6 DMA control Enable - 

9-1 Code page Katakana - 

9-2 Foreign language characters Japan - 

9-3 Kanji Enable - 
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